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Writing the display unit’'s Log Data to Excel
|

9.1 Writing the display unit’'s Log Data to Excel

[Action Example]
Write the alarm log data stored in SRAM of display unit in an Excel file at 15:00 every day.

~ ™~
A I B [ © [ D [ E T
1 |Report of Log Data
2
3 |Trigger Da Trigger Time Messagg(s) Acknowledoed |Recowverd
4 12/20/2007 10:30:00)Abnormal Pressure 10:35:00
5 12/20/2007 11:00:00|Abnormal Pressure 11:32:00) 11:32:30
PC (4] 12/20/2007 11:30:00)Abnormal Temp 11:353:00) 11:3530
. 7 12/20/2007 12.00:00|Abnormal Pressure 12:03:00) 120530
(Node Name: PC1) & 12/20/2007 12.30:00[Abnormal Temp 123200
a
[ ) 10
al
il
s
. 14
i)
— _J

At 15:00
everyda

GP3000
(Node Name: AGP1)

This section describes the setting procedures for executing the above action (ACTION) as an example.

NOTE | *© Refer to the "GP-Pro Ex Reference Manual" for more details about alarms.
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Writing the display unit’'s Log Data to Excel

[Setting Procedure]

1

Creating a Template (page9-4)

This step creates a template to write log data on.

. 4

Starting 'Pro-Studio EX' (page9-5)

This step starts "Pro-Studio EX'.

.

Registering Entry Nodes (page9-5)

This step registers the PC and the display units as
entry nodes.

¢

Specifying an Excel Template and its Output
Book (page9-6)

This step sets the following items:
 Specify a template
* Specify an output file

¢

Setting Content of an Excel Template (page9-
10)

This step sets the following items:
* Log data type
 Data specification method

¢

Setting ACTION Node/Process Completion
Notification (page9-19)

This step sets the name of an ACTION node and the
alert setting whether it should be tuned on or off

p

Verifying Setting Result (page9-21)

This step verifies setting results on the setting
content list screen.

.

Saving a Network Project File (page9-23)

This step saves the current settings as a network
project file and reloads.

.

Transferring a Network Project File (page9-

This step transfers a saved network project file to the
display unit.

24)
A 4

10

Executing ACTION (page9-25)

This step verifies that the log data of the display unit
is written in the specified area of Excel when the
preset trigger condition has become effective.
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Writing the display unit's Log Data to Excel

9.1.1 Creating a Template

This step creates a template to write log data on.

1 Start 'Microsoft Excel' and create the sheet below in Sheet 1.
When you execute ACTION, log data will be written in.

A B C D E
Report of Log Data

Trigger Day |(Trigger Time |Message(s) [Acknowledged |Recoverd

1
2
3
4
5
6
7
8
9

10

11

12

13

1A

2 Save the file on PC desktop naming "template.xIt".
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|

9.1.2 Starting 'Pro-Studio EX'

This step starts 'Pro-Studio EX'.
Refer to "3 Trial of Pro-Server EX" for details about starting method.

9.1.3 Registering Entry Nodes

This step registers the PC and the display unit connected with network as nodes.

Refer to "31 Node Registration" for details about entry nodes.

Node Name :PC1

IP Address :192.168.0.1

Node Name :AGP1
IP Address :192.168.0.100

Device/PLC Information

r/ Ex /4

Entry node Setting item Setting example
Node Name PC1
PC
IP Address 192.168.0.1
Type GP3000 series
Display Unit Node Name AGP1
IP Address 192.168.0.100
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Writing the display unit's Log Data to Excel

9.1.4 Specifying an Excel Template and its Output Book

Specify the form template and output book created in (1).
Refer to "9.2 Setting Guide" for more details.

Setting item Setting content

C:\Documents and

Specify a Template | Template File Settings\Administrator\Desktop\templete.xls

Folder Name C:\Documents and Settings\Administrator\Desktop
File Name GP log data.xls
Start with the output
Output File file displayed Checked
Do not save the output
file when ACTION Not checked
runs.

1 Click the [Feature] icon on the status bar.

"a:i' Pro-Studio EX test.npx

File Edit Tool Programming Assist  Setkting  Help

‘Fy Start 2w Qﬂ Mode | 2 /..) Syrnbal | .&5 Feature | 2 Save .
= L

—Sample Wizard

On the 2nd time or |ater,
zamplez will be added to the

itk
=N New Form 2-Way Network
@ Recipe 2-Way netwotk iz a netwotk connecting FA unite and

it Excel format by acquiring data of the GPs and the v
connected to the GP s, and tranemit the information of
connection vnits.

L
7 Data Logaging
[

Send Mail

Pro-Studio EX

2 Select [ACTION] from the tree display on the left of the screen, then click the [Add] button.

'aja' Pro-Studio EX test.npx

File Edit Tool  Programming Assist  Setting  Help

Fy Start | 2 Q_ﬂ Mode | 2 /._» Symbol |,

Add h | |k |

Edit | Delete |
ACTION
Trigger Condition In addition
Data Tranzfer us::.ng applic
e b Device Cache using Acce
It the Pro-3

referred to ¢
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Writing the display unit's Log Data to Excel

3 Click the [ACTION Type] list button, and select "Create form using Excel.".
Then, enter the name of ACTION to set in the [ACTION name] field. In this example, enter "GP Log Data".

NOTE | © [ACTION Name] can be an arbitrary name.

Set ACTION Mame,/Parameter B

Add a new ACTIOMN.
Specify an SCTION name, and set its parameter.

ACTION Type| Create farm uszing Excel.
Create form using E
Wiites D ata bo C5Y file,
ACTION Warne|'wites Data from C5V file.
Upload of GP JPEG Data.
Upload of GP Log Data.
wihites D ata bo E-tail. e
Upload to the database.

Download from the database. &7

& —) @

i[5 | Cancel |

4 Click the [Click here to set the ACTION parameter] button.

ACTION T.'r'IJBI Create form using Excel. j
™ Display the Actions of the old version of Pro-Server
ACTION NamelGPngDa[d

Click here
to set the ACTION parameter. [}

v ) @

N |
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|

5 Make settings regarding an Excel template and its output file.
1) Click the [Reference] button of [Template File] to set the template file "templete.xIt" which you created.

Create form using Excel

CD ocuments andd Settings\administratonD esktoptemplate - [

E:‘Program Files\Pro-face'Pro-Server EXWPXDataBaze
Feport_ %5 Y%h %D xls

2) Click the [Reference] button of [Folder Name] and specify "Desktop" as a folder to save the output file.

CHDocuments and Settings\AdministratonD eskiop
Repart_%v%M%D s |
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|

3) Set the file name "GP Log Data.xls" in the [File Name] field for the output file to set.

D ocuments and Settings\ddministratonD esktop
GPLogData. ks

NOTE | © "% Y%M%D" is preset as "Year/Month/Date". For more details, refer to "37.1 Restrictions on

Names".

4) Check the [Start from Displayed State] check box.

CDocuments snod Settings\administrstorDeskiop
GPLogDsEta .«

NOTE | *© If you check [Start from Displayed State], you can read/write data with an output file displayed.
This is useful if you need to confirm data immediately.
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9.1.5 Setting Content of an Excel Template

This step sets the content of the Excel template for writing log data in Excel.

The example below shows the setting of data write area (Log data area in GP) in a template.

Refer to "9.2 Setting Guide" for more details.

Target Cell Range

A | B |/ ¢ D E
1 |Report of Log Data
2
3 |[Trigger Day Trigger Time AMessagets) Acknowledged |Recowverd
]
B
5]
7
8
G
10
11
12
13
14
15
Setting item Setting content
Target Cell Range AdtoEl3
Entry Node AGP1
Data Type Block 1 Data
Alarm Type Alarm History

Specification Method of File No.

Current Data (Data in SRAM)

Action when cell gets full

Clear and Overwrite

Trigger Condition

Specified Time (15:00)

Pro-Server EX Reference Manual
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Writing the display unit’s Log Data to Excel

1 Click the [Edit Template] button.

Create form using Excel

“ersion 1.10
Template Designation
Fleaze specify the name of Excel template file that iz the source of forms.
“when you uze the wizard, the theme template file iz copied ta a file with this name.
When you create a new template, please specify the file name.
Template File IC:iDocuments and Settings\AdministratorDesktoptemplate x Reference
L}
Eciit Template [
. - -

2 Set a data write area.

1) Click the [Log Data in GP Area] icon on Excel.

£4 Microsoft Excel - template.xit

J File Edit Wwiew Insert Format Tools Data Window Help Exce
D s &= rwe
I @aF o rEBA AR
|8 P ¥lgie & o 3w e 1]

A \Wdl =

A | B | C
Report of Log Data

Trigger Day Trigger Time  |Message(s)

Lo S T e

NOTE | * Selecting [Log Data in GP Area] from [Excel Action] of the menu displays the same screen.

=lp | Excelaction()

Device One-shot AreallM)
| Device Logging Areall) |
i ) -

ﬂ Log Data in GP Areall) k

S oo ey
=

——

| ¢& Execution Sequence List(E) I
@': Buttanify Trigger Condition(B)
[Z] Action Area ListiL

Tools(T) »
Communicakion(iC} 4
f: Area display(0)

‘ersion Infoid)
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2) Click the cell range specify button of [Target Cell Range].

&' Log Data Upload [_ O] x|

Action Settings | Trigger Condition Settings |

Target Cell lﬁ
Range IW1 .l Node (Trigger-Source Mode) |

Logging Do j (* GP Series
s SP-5B40MfinGP / SP-5B10 / GP4000VLT4000 Series /

GP3000 Series / LT3000

™ Show CSV File ltems
—Specification Method of File No.

| Curent Data (SRAM/Real Time) |

Action when cell gets full ¢ Clear and Overwrite ¢ Scroll " NewSheet  Loop

™ In creating a sheet, clear the specified cell range and then start.

0K I Cancel

3) Drag the mouse to specify the area to use for data logging (cells A4 to E15). Then click the [OK] button.

A B C D E

1 Reéor‘tofLoélbata

2

3 |Trigger Day |Trigger Time |Message(s]) |Acknowledged [Recoverd

a| :

51 ;

6 |

7 ;
,

8 |

3 | Flease specify the range. :
|sas4sES13 ;

10 | !

11 | oK I Cancel | !

125 1| 1 < | E

sl | | Jo d

14

4) Click the list button of [Node] and select "AGP1" as a data transfer source node.

&' Log Data Upload [ (O] %]

Action Settings | Trigger Condition Settings I
Target Cell -
i [sasa:sEs13 k] MNode

Logging Data

ie .- ger-Source Node
¢~ SP-5B40/WinGP T SP-5BTU7 GPATUILT4000 Series /
GP3000 Series / LT3000
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5) Select "Alarm Block 1 Data" for the data type and "Alarm History" for the alarm type.

#" Log Data Upload

(=]
Action Seftings | Trigger Condition Settings I
Target Cell E
= [easasEsT3 S| Hode
= GP Seri
A= Block 1 Data =l -

SP-

Alarm Type = Mlarm Active % Alarm History " Alarm Log

6) Select "Current Data (SRAM/Real Time)" in [Specification Method of File No.].

Specification Method of File Ha.

I
Current D3 2al Time]
Latest Dats [In CF-Card]

Indirect Specification by Device Address [In CF-Card]
Specify File Mo. [In CF-Card]

7) Select "Clear and Overwrite" in [Action when cell gets full].

G'Elear and Ovvenurite

[~ In creating a sheet, clear and then start.

Action when cell gets full

= Soroll  NewSheet € Loop

oK Cancel

Pro-Server EX Reference Manual
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|

3 Set trigger conditions.
1) Click the [Trigger Condition Settings] tab.

&' Log Data Upload

Action 5 ettings| | Trigger Conﬂon Settings |

Target Cell [F343EST3 il Mode 4GP = _l |

Ranas

The "Trigger Condition Settings" screen will appear.

SIS B3

#" Log Data Upload

Action Settings  Trigger Condition Settings |

0

‘When the specified tngger type [under-condition button] is satisfied, this area is executed,
Fleaze specify a trigger type.

Action Area Mo.

‘ Mew Trigger Condition ‘ ‘ Mew Trigger Button ‘
—GF Log Data Upload —Clear Cell when the following condition is ——
satisfied.
Edt | Delete | Edt |  Delete

| Trigger Condition

| Trigger Condition

*

*

@ If two or mare are specified, the Action is executed when any of them iz satisfied.

For more complicated operation, please configure from [Excel Action]-[Execution
Sequence List] it the menu.,

Ok Cancel

9-14
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2) Click the [New Trigger Condition] button.

MHew Trigger Button ‘

‘ Mew Trigger Condition

—Clear Cell when the following condition iz
satisfied.

I Cog Cratg Crpnoag

Edt | Dot | Edt | Dt

| Trigger Condition | Trigger Condition

*

*

@ IF two or mare are specified, the &ction is executed when any of them is satisfied.

Far maore complicated operation, please configure from [Excel Action]-[E xecution
Seqguence List] in the menu.

NOTE | °© You can create a button on the Excel sheet, and use this as a trigger condition to execute ACTION.
Refer to "5.6 Creating Trigger Buttons in a Form" for details.

A B C D E F G H
1 |Report of Log Data
2
3 |Trigger Day |[Trigger Time |Message(s) [Acknowledged |Recoverd
4
5]
6
7
g Excel Fom Action
10
11
12
13

3) Click the [New Trigger Condition] button.

Set Trigger Condition B

Specify a tigger condition of the ACTIOM.

Mew Trigger Condition k

Cloze |
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Writing the display unit’s Log Data to Excel

4) Enter the trigger condition name "Read GP Log Data" in [Trigger Condition Name], and select "AGP1" in

[Node Name] as a name of the data transfer source.

lcs Eonﬁg:ﬂg IH eadGPLogData
) Find Mode
Node Name [P -] S addNode |
FL1 '
[ | e |
m Jl
| |

5) Click the [Specified Time] button in the [Condition 1] tab, and enter "15" and "0" in [Specified Time]. Then
click the [OK] button.

Condition 1 |

Specify the Trigger Condition.

b5 When Tuned ON | Whie Deviceis ON | %2 while Condiion Satisfied |
[¢) Specitied Time | Whie Device is OFF | ;| When Condiion Satisfied |
G Constant Cyclel when Device OM | IEI “w'hen Partner Mode OM |

when Device Changesl ‘when Device OFF | % when Partner Mode: DFFl

Specified Timp

Detail Settings QK. Cancel
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6) Click the [Close] button.

Set Trigger Condition B

Specify a trigger condition of the ACTIOMN.

MHew Trigger Condition
FReadGFPLogD ata i Edt F——

AGP1
At 15hourlnin

Cloze [ |

7) In [GP Log Data Upload], click the blank line of [Trigger Condition] and select "ReadGPLogData" as a

trigger condition.

‘ Mew Trigger Condition H MHew Trigger Button ‘

Clear Cell when the following condition is
satisfied.

Edt |

—GP Log D ata Upload

Edt | Delete | Deete |

Trigger Condition

@ IF twi or mare are specified, the Action iz executed wheh any of them is satisfied.

For maore complicated operation, please configure from [Excel Action]-E zecution
Sequence List] in the menu.

8) Click the [OK] button.

This is the end of the content settings of an Excel template.
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4 Close "Excel'.

Microsoft Excel - template.xlt =] E3
<l File Edit iew Insert Format Tools Data Window Help Excelaction(a)
q Hew... i 5| | e 2 N B
[= Open... Chel+o [
LA R
Close
& save Chrl+5

= elFormOcyx. FormRangelnfo. 1","")
Save as Web Page... [ E [ F [ G| H [ [ J [ K

Page Setup...
Prink Area 3
@ Prink Prexview

Print... Chrl+P

Send To 3

1 \Documents and Se.. . \exceltablexls, xls
2 \Documents and Settingsia, . \Bookl xls
3 \Documents and Settingsim. .. \aaaa.xls

4 \Documents and Settingsimb, ., itest.«ls

E—)

18 .
14 4» M Sheetl |41 JJ
'@ | OF G 0t o

Ready [ e e e

The following dialog box will appear, asking you if you want to save changes before closing. Click the [Yes]

button.

Excel Report Action - Completion Confirmation

@ Sawve changes to the template and Finish editing?

Yes Mo Cancel

5 On the "Create form using Excel" screen, click the [OK] button.

Falder Mame IC:lDoc:uments and SettingsiAdministratonD esktop Reference |

File Mame IGPLUQD&t&ﬂS Return to Detault Settings |

[ Start from Displayed State

r Do nat zave the output file when ACTIOMN wns.
[Pleaze use the Save or Save by Macro of Excel ]
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9.1.6 Setting ACTION Node/Process Completion Notification

This step sets the name of an ACTION node and the alert setting whether it should be tuned on or off when the
ACTION is completed.

* ACTION Node : PCl1
e Receive Notification: OFF

1 On the "Set ACTION Name/Parameter" screen, click the[Next] button.

Set ACTION Mame, Parameter B

Add a new ACTION.
Specify an ACTION name, and set its parameter.

ACTION T}'DEI Create farm using Ewxcel. j

" Display the dctions of the old version of Pro-Server

ACTION NamelGPLogData

Click. here
ta set the ACTIOM parameter.

2 Click the list button of [ACTION Node] and select "PC1" as a node where ACTION operates.

Set ACTION Node,/Process Completion Notification

R
ACTION e [EFESEDEET

Specify an action node Windows PC) where the ACTIOMN works practically.

ACTION Node

Pleaze specify the notified device that will be infarmed of
the execution of the ACTIOMN. After the execution of the
ACTION, it will be is turned on.

Pro-Server EX Reference Manual 9-19



Writing the display unit’'s Log Data to Excel
|

3 Turn off the check box of [Receive Notification Exists], if checked.

ACTION Node

FC -

[~ Receive Motification E sists

Flease specify the notified Hevice that will be infarmed of
M. &fter the execution of the
ACTION, it will be is turned on.

Device Name
JHINTERNAL =

Fotified Device
= | =l
DetaType BRI

NOTE | © Do not check "Receive Notification Exists".

4 Click the [Complete] button.
The "Set ACTION Node/Process Completion Notification" screen will disappear. On the left of the screen, the
name of ACTION you set will appear.

Device Mame

[#INTERNAL =

Muotified Device
P Al
DataTope [N

Back | | Complete [kl | Cancel |

N’

This is the end of the settings of the ACTION node and process completion notification.
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9.1.7 Verifying Setting Result

This step verifies setting results on the setting content list screen.

NOTE | ° Incase of the "Excel Report" ACTION, you cannot add, edit or delete trigger conditions from

"Trigger Condition/Process List per ACTION". To change the settings, click the [Parameters
Settings] button and change the settings in [Edit Template] on Excel.

1 Select the ACTION name "GP Log Data" from the tree display on the left of the screen.

“.3' Pro-Studio EX *npx

File Edit Tool Programming Assist

F’;I Start »Qj Nods

Add | |t |

Edit | Delete |

Ity ReadGPLogD ata
¥ Data Transfer
b Device Cache

Confirm that the setting content appears on the right of the screen.

%mPro-studio EX  7.npx

[_[O]x]
Fle Edit Tool Programming Assist Setting Help
i “ o = .
‘ p;,l Start | 33 Qﬂ Node »‘ /..» Symbol | 33| @ Feaure 33| | Save »‘@ Trarster ‘ Horior
—ACTION-Specific Trigger Condition/Process List ACTION
Add Impart:
Aedd | Edit | FHeleaze) I Delete ACTION
Edit Delete lﬁ
4| 4| i Data Sourcs Node AGP1 GPLogDats z
~ ACTION Trigger [t 15kourmi FRename
B eE Condtion I — } Dats __ R |
Completion | ‘ [Feadt Create form using Excel
"TE? ReadGPLogD ata RETEER
¥ Data Transfer

~ ¥ Device Cache

Set Parameter

I

# ACTION Node
PC1

Pro-Server EX Reference Manual
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2 Select the trigger condition name "ReadGPLogData" from the tree display on the left of the screen.

% Pro-studio EX 7.npx

File Edit Tool Programming &ssist

@ Start »[Ei Nads

Fi¥als} | |port |

Edit | Delete |

Elv ACTION
Gow Trigger Condition

- v Data Transfer
- » Device Cache

Confirm that the setting content appears on the right of the screen.

“," Pro-Studio EX  Z.npx

File Edit Tool Programming Assist  Setting  Help

@ Start | 2> [Qi Nads | 2 'L» Symbal | 2>

é Feature 2 IE:I Save | 2 m Transfer [@ honitar
A

Status
P | T | Sequence Diagram by Trigger Condition
Y | L 3 | Collapse | Transfer ACTION /D ata
Edit | Delete | :
ReadGPLog Edit |=—— Feature ... | Source | | Destinat... | Feceive/Process Co... |
Bl v ACTION GPLogD... AGP1H#.. - PCLGP.
. x| GPLogData G

- Trigger Condition

At 15hourOmin

» Data Transfer

L ]
v Device Cache

Frocess Co

Processing j/

Error Code |
IP Address |

This is the end of the verification of the settings.
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9.1.8 Saving a Network Project File

This step saves the current settings as a network project file and reloads to 'Pro-Server EX'.

Refer to "25 Saving" for details about saving a network project file.

mrnand © 'Pro-Server EX" reads a created network project file, and then executes ACTION

according to the settings in the file. The settings therefore need be saved in the network
project file.

» Be sure to reload the network project file to 'Pro-Server EX'. If not, ACTION will not work.

+ Path of network project file : Desktop\monitor.npx
+ Title : EXCEL Report ACTION

9.1.9 Test Read

You can check if the settings are correct before transferring a created network project file to entry nodes.

When executing ACTION, the setting data is output to an output file. However, when executing a test read, it is
reflected in a template file.

NOTE | © You do not necessarily have to perform a test read.

If you skip this, proceed to "9.1.10 Transferring a Network Project File".

» To perform a test read, it is necessary that 'Pro-Server EX', to which a created network
project file has been loaded, is running.

1 Click the [Feature] button.
2 Click "ACTION" from the tree display on the left of the screen, then click the [Edit] button.

3 On the "Set ACTION Name/Parameter" screen, click the [Click here to set the ACTION parameter] button.

4 On the "Create form using Excel" screen, click the [Edit Template] button.
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5 With the ACTION area selected, click the [Test Read] icon.

= | H-5-A- ?HMEE MW o s EEEE A
=
WEED” ProExcelFormDcx FormRangeInfa1 ™, ")

A [ B8 | c [ D | E |
Report of Log Data

Trigger Day Trigger Time |Message(s) Acknowledzed |Fecoverd |

mmbmm_.ocom-qc)mbml\)—-

The setup contents will be read in the template.

NOTE | *© Referto "9.3 Restrictions" for details about the restrictions on test reads.

9.1.10 Transferring a Network Project File

This step loads a saved network project file to 'Pro-Server EX' and then transfers to entry nodes.

Refer to "26 Transferring" for details about transferring a network project file.

NOTE | *© Be sure to transfer a network project file. If not, ACTION will not work.
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9.1.11 Executing ACTION

This step verifies that enabling a trigger condition activates ACTION, opens an Excel book (file name: "GP error

log.xls"), and then writes the log data of display unit in the specified location in Excel.

A | B | B | D [ B ]
Report of Log Data
Trigger Day Trigger Time  |Message(s) Ackrowledzed |Recoverd
12/20/2007 10:30:00 | Abnormal Pressure 10:35:00
12/20/2007 11:00:00 | Abnormal Pressure 11:532:00] 11:32:30
1272042007 11:30:00|Abrormal Temp 113300 1135430
12/20/2007 12:00:00|Abnormal Pressure 12:03:00] 12:05:30
1272042007 12:30:00|Abnormal Temp 123200

,m_,hmm_.ocom-qc)m.bml\)‘—-

NOTE | * Iferror occurs, you can check the log in the Log Viewer. For more details, refer to "28.5
Monitoring System Event Logs".
* Ifyou want to achieve faster communication during ACTION, refer to "29 Tips for Faster

Communication".

This is the end of the explanation of this ACTION.
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Setting Guide

9.2 Setting Guide

This section explains how to set the parameters of ACTION.

9.2.1 "Creating form using Excel" Screen

Fn5.1.2 Setting Guide"

9.2.2 "Log Data Upload" Screen
B "Action Settings" Tab

#" Log Data Upload [ [
Action Seftings | Trigger Condition Settings I
Target Cell I— P— -
Range SAST =k| Node II_Tngger Source Node) J |
& )
Logging Data ﬂ GP Series .
~ SP-5B40MfinGP / SP-5B10/ GP4000/LT4000 Series /
GP3000 Series / LT3000
I™" Shaw CSV File ltems
Specification Methed of File Na.
| Cument Data (SRAM/Real Time} =l
Action when cell gets full & Clear and Overwrite & Scroll " MewSheet  Loop
™ In creating a sheet, clear the specified cell range and then start.
oK I Cancel

Setting item Setting content

Specifies the cell range to which data will be written.
Clicking the button can select the cell range on Excel.

* For the process on how to select cell ranges, refer to "MAction Area Settings" in "5.1.2
Setting Guide".

 The useful function is available to check the specified cell range (Action Area). Refer to
"M Action Area List" in "5.1.2 Setting Guide".

Target Cell Range
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Setting item

Setting content

Node

Selects a node to read log data.

* Clicking the [...] button can retrieve or add entry nodes.
* Selecting "(Trigger-Source Node)" will select the entry node that has triggered the
action.

Data Type

Selects a log data type to write in a form.
Selectable log data depends on the type of display units.

SP-5B40/WinGP / SP-5B10 / GP4000/LT4000 Series / GP3000 Sereies / LT3000
* CSV Data (Recipe)

+ Alarm Block 1 Data - Alarm Block 8 Data

* GP Screen Data (Jpeg)

» Sampling Data

* GP-PRO/PB Logging data (compatible)

* GP-PRO/PB Trend graph data (compatible)

* GP-PRO/PB Sampling data (compatible)

* To upload line graph data, sampling data and logging data in a project file converted
from 'GP-PRO/PB III for Windows', specify "compatible" of the corresponding data.

* You cannot write the "GP Screen Data (Jpeg)" log data to models without a CF/SD card
slot.

GP Series

» Logging Data

* Trend Data

* Alarm Active

+ Alarm History

* Alarm Log

* CSV Data (Recipe)

+ Sampling Data

+ Alarm Block 4 Data - Alarm Block 8 Data
* GP Screen Data (Jpeg)

* You cannot write the "GP Screen Data (Jpeg)" log data to models without a CF card slot.

Alarm Type

Other than the "GP Series", when you select "Alarm Block * Data", you can select the
alarm type from "Alarm Active", "Alarm History", or "Alarm Log".

No. of JPEGs (Figures)

When you select "GP Screen Data (Jpeg)", set the number of screens to read into the area.

Show CSV File Iltems

Check if you want to display the title content in Excel.

* This does not appear if you select "CSV Data" or "GP Screen Data (Jpeg)".
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Setting item

Setting content

Specification Method of
File No.

Selects where log data to read is stored.

* Current Data (SRAM/Real Time)
Reads out current data stored in SRAM of the display unit.
» Latest Data (in CF-Card)
Reads out the latest data from those stored in a CF card (or SD card) of the display unit.
« Indirect Specification by Device Address (In CF-Card)
Reads out a specified number file from data stored in a CF card (or SD card) of the
display unit.
In this case, the number is specified by device indirectly .
Specify Node, Device Name, and Device Address.

Specification Method of File Mo.
Ilndirect Specffication by Device Address (In CF-Card) j
Node Il_'l'rigger—Source Mode) j _I
Device Name I j
Device Address/Symbol ) hd

» Specify File No. (In CF-Card)
Reads out a specified number file from data stored in a CF card (or SD card) of the
display unit.
In this case, specify the file number of the CF card (or SD card).

Specification Method of File No.

|Specify File No. {in CF-Card) |

b =

File No.

Specification Method of
Sampling Group No.

If you select "Sampling Data" for display units other than "GP Series", set how to specify a
sampling group No.
« Indirect Specification by Device Address

Specify a sampling group No. by device indirectly.

In this case, specify Node, Device Name, and Device Address/Symbol.

Specification Method of Sampling Group Mo.

IIndirect Specification by Device Address j
IITﬁgger—Source Node) ﬂ |
Device Mame | R
Device Address/Symbel 28| v

Node

» Specify Sampling No.
Fix and specify a sampling group No.
In this case, specify a group No.

Specification Method of Sampling Group MNo.

I Specify Sampling Mo. j

h =

Group No.
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Setting item Setting content

Sets the action when the specified cells have got full.

 Clear and Overwrite
Clears data write cells to start writing from first.

When adding D to the full cell,

A D
B | =
C
+ Scroll
Scroll up as a whole to write new data at the bottom. At this time, data at the top will be
deleted.

You can specify this option when selecting "GP Screen Data" for the data type.

When adding D to the full cell,

A B
B = C
C D

Action when cell gets

full * New Sheet

Continues writing on a new sheet.
All the features being output on the sheet will be copied to the new sheet.

When adding D to the full cell, Further, adding E,
A D D
B = =) E
C
Sheet1 Sheet2 Sheet2

* Loop
Overwrites from top in sequence.
You can specify this option when selecting "GP Screen Data" for the data type.

When adding D to the full cell,

A D
B = B
c c

In creating a sheet,
clear the specified cell
range and then start.

Before copying a sheet from the template file, if data are written in the cell range of the
sheet, clears the data and starts copying.
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B "Trigger Condition Settings" tab

#" Log Data Upload [ =]

fction Settings  Trigger Condition Settings |

0

‘when the specified trigger type [under-condition buttan] is satisfied, thiz area iz executed.
Fleaze specify a trigger type.

Action Area Mo.

‘ Mew Trigger Condition ‘ ‘ Mew Trigger Button ‘
—GPLogDatalpload ——— [ Clear Cell when the following condition i —
satizfied.
Edt | Delete | Edi | Delete

| Trigger Condition | Trigger Condition

* *

@ If v or maore are specified, the Action iz executed when any of them is zatisfied.

For more complicated operation, please configure from [Excel Action]-Execution
Sequence List] in the menu.

Ok Cancel
Setting item Setting content
Action Area No. Displays No. allocated to each ACTION area by template.
New Trigger Condition D1§plays the "Trigger Copdltlon Setj[{ngs dialog box.
Click here to set a new trigger condition.
New Trigger Button Displays the "Create Trigger Button" dialog box.

Refer to "5.6.2 Setting Guide" for more details.

Selects a trigger condition to read log data.
Click the blank line of [Trigger Condition] and then the list button to display the registered
trigger condition.

GP Log Data Upload NOTE

» When plural trigger conditions have been specified, satisfying at least one of those
conditions executes ACTION.

 Clicking the [Edit] button can edit the specified trigger conditions.

 Clicking the [Delete] button deletes the specified trigger conditions.
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Setting item Setting content

Clears cells if a set trigger condition is satisfied.
Click the blank line of [Trigger Condition] and then the list button to display the registered
trigger condition.

Clear Cells when the

following condition is NOTE

satisfied * When plural trigger conditions have been specified, satisfying at least one of those
conditions clears cells.

 Clicking the [Edit] button can edit the specified trigger conditions.
 Clicking the [Delete] button deletes the specified trigger conditions.
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9.3 Restrictions

B Combined Cells

Do not set an ACTION area on combined cells.

For example, if you set an ACTION area in the cells as shown below, correct operation cannot be guaranteed.

A B & ]
D100 IR0} Moz 0103

B Over-pasted ACTION Areas

When you over-paste plural ACTION areas of different size, read/write will be executed in the pasted order.

B Excel Window

If the setting screen is hidden behind the Excel window, the screen and task tray windows will blink and notify the

user. Blinking will stop automatically when the setting screen comes forward.

B Operation in ACTION area when error occurs
When you actually write/read in "GP Log" function and exceed the ACTION area, perform the common operation
as follows:
1) When performing a test read/ a test write
Error screen is displayed.
2) When executing ACTION in runtime
It will be recorded as ACTION error in the Log Viewer of the 'Pro-Server EX'.

B Functions which are not executed by a Test Read
The following functions are not executed by a Test Read.
"Action when cell gets full"

"Clear the cell range specified in creating a sheet to start"

B In the case of closing the displayed output book
If you have mistakenly closed an output book of Excel Report ACTION, follow these steps to open it again:
Dragging and dropping the book to open will make it read-only and the start button etc. invalid.
1. Double-click the output book.
2. When the following dialog box appears, select "No" to open it.

Microsoft Excel [ ]

i Report_20060415.xls is already open. Reopening will cause any changes you made to be discarded, Do you want to
\\J) reopen Report_Z0060415,x|s7?
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B Receive natification

You cannot set the receive notification which indicates the completion of ACTION.

B When setting “Trigger-Source Node”

When setting "Trigger-Source Node" at node in Excel Report action, node type and device are uncertain.

Therefore, the device address is displayed in red.But, it is no problem.

W Edit the output file

While Excel Report Action is executing, you can not edit the output file.
Therefore, it becomes very difficult to operate Excel at the setting in which the Trigger condition satisfies at a
short cycle.Moreover, the following error message is displayed when the Action is executed during editing the

output file.

Excel Form Action - Error E

Q SAAI040:When the cell is in the edit mode, no ACTION can be executed. Please close Edit Cell before execute the

ACTION again, (20b00S25h)

B Save the output file Do not use

Do not use multiple Excel form actions to save output files to the same destination.

If you set the same destination for file outputs, Pro-Studio and Pro-Server EX may not be able to run.

B Restrictions on reading Alarm and Sampling Data on the CF Card

* In GP-Pro EX, use "yy/mm/dd" for the date format. When the CSV file on the CF card does not use "yy/mm/
dd" for the date format, the wrong date may be output.

When output to Excel, the date uses the "20yy/mm/dd" (or "19yy/mm/dd") format.

*  When using a version of GP-Pro EX before V3.12, or a version of Pro-Server EX before V1.32, do not use the
[Set number of files in destination folder on external storage] option in GP-Pro EX. You cannot read files
stored [Alarm] or [SAMP**] sub-folders.

+ If [Multiple Line Message Output (Save Alarm to CSV)] is enabled in GP-Pro EX alarm settings, when
opening the CSV file, you will notice that messages with line breaks are output to the next cell down.

If [Multiple Line Message Output (Save Alarm to CSV)] is disabled, the message up to the line break only is
saved to the CSV file.

B Restrictions on reading Alarm and Sampling Data in SRAM
* Regardless of the date format defined in GP-Pro EX, dates are handled with the "yy/mm/dd" format. When
outputting to Excel, the date format is "20yy/mm/dd" (or "19yy/mm/dd").
+ If [Multiple Line Message Output (Save Alarm to CSV)] is enabled in GP-Pro EX alarm settings, each line in

a message is output to a different cell.
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If [Multiple Line Message Output (Save Alarm to CSV)] is disabled, the message up to the line break only is

saved.

B About the 1500 row limit for Action Area settings

Exceeding 1500 rows for the Action Area could cause the action to run longer. If you use Device One Shot or

Device Logging's text conversion, the action could take even longer.

B Restrictions on Copying or Cutting and Pasting the Action Area
When you paste the Action area using Ctrl+C & Ctrl+V or Ctrl+X & Ctrl+V, specify [Target Cell Range] for the

copied Action area.

The Action area just after pasting remains the same [Target Cell Range] as that for the original Action area.

A | B | G D |

—
[m}

o B iy I o R o

B Excel Auto Save Function
The Excel auto save function does not operate due to the Excel restrictions.To save automatically, create the Excel
save macro using the following procedure and execute the created save macro by Action.

1 Open a template you want to save automatically using 'Pro-Studio EX'.

Create form using Excel

Wersion 1.22

— Template Designation

Pleaze specify the name of Excel template file that iz the source of forms.
When pou uze the wizard, the theme template file iz copied to a file with this name.
Wwhen pou create a new template, please specify the file name.

Template File |C:\Doc>uments and Settings\administratonDesktopttemplate .« Reference

Edlit Template

—Output File
The template file stores setting info. The actual output result will be dizplaped it the following Ffile.

IC:\Documents and Settings\administratorDeskiop

Folder Mame

File Mame IRepor‘t_%Y%M%D s Return to Default Settings

W Start from Displayed State

['o not save the output file when ACTION runs.
n
[Plzaze use the Save or Sawe by Macro of Excel )

0K Cancel
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2 Select "Macro" and "Record New Macro" from the "Tools" menu.

bt | Tools Data Window Help Excelction{a)

% speling.. 7|4 4] | i@ >

AutoCorreck. ..

J Arial -

Share Workbook, ..
Track Changes »

|21

IMerge Waorkbooks, ., | F | = | H |

Protection 3
Online Collaboration ¥

Goal Seek. ..
Scenarios.. .
Auditing 3

Add-Ins. ..

Customize. .. Security ...

Options..., -
= -] Wisual Basic Editor Alk+F11

B [icrosolt ScriptEditor. AlRShifELL

3 Enter the macro name "Macro1" and click the [OK] button.

Recording the macro starts.

Record Macro E E
Macro narme:
IMachl
Shortcut key: Stare macro in:

Ctrl+|_ IThis workbiook, j
Descripkion:

Macro recorded * [+ [200% by Frttdd

oK & I Zancel

4 Select "Save" from the "File" menu.

"Macrol" is recorded in the macro.

crosoft Excel - template2._xlt

Chl+h |-
bl |
m ]
J Save as'deb Page...
Page Setup... I
L Print Area »
| 2 & prin... Cri+p
=N
4 Send To »
5]
5 1 \Documents and Set. .. \convert_DOZ,xls
7 2 \Documents and Set...\convert_D0O1.xls
i 3 \Documents and Setting. .. \templete. xls
N ¥ |
107
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5 Select "Macro" and "Stop Recording" from the "Tools" menu.

Recording the macro is complete.

Tools Data Window Help Exceldction{a)
¥ ¥ Speling... F7 FAYl | i 2 >

Share Workbook. ..
Protection 3

J Arial -

= Online Collaboration *

) Il
=
Optians. .. Sacuik

¥

] Visual Basic Editor Alt+F11
& Microsoft Script Editor  Ale+Shift+F11

6 Select "Execution Sequence List" from the "Excel Action" menu.

1 | Excelfction{a)

Device One-Shot Areall)

| | Device Logging Areail)
% Recipe ArealR)
ﬁ> Log Data in GP Arealll)
S

E| Action Area List(D)

Tools{T) 3
Cormmunication{C) 3
ﬁ[ Area display(o)

‘Wersion Infold)

7 Create the trigger condition save automatically.
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8 Select the created trigger condition and "Excel Operation Function".

l—
T | — | | |
CreateForm b4 Ecel Operation Function k

£ kA L) Pt

o | s |

10 Click the [OK] button.
11 Finish editing the template.

12 Save/Reload the setting contents.

According to the created trigger condition, the template is automatically saved.
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